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nXtRender Getting Started
Get started with an overview of Rendering, Installation, Licensing and some video tutorials.

 
Sala 020612 by Jorge Javier Lara Dominquez
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nXtRender Rendering Overview
nXtRender creates stunning life-like images from AutoCAD models. nXtRender uses Ray Tracing and photometric rendering
technologies from inside AutoCAD to create high-quality photo-realistic images from 3D Models.

Rendering by Surya Murali using nXt Engine

With nXtRender, creating presentation quality images from AutoCAD models is easy. Simply add materials, lights, sun, sky
and then render the model.

General Features
Easy to use, works seamlessly inside AutoCAD, and provides a host of features that speed and simplify image rendering.

Uses both raytracing and Indirect Lighting to create sophisticated single-frame images and animations.

Automatically calculates indirect light, hard and soft shadows, color bleeding, reflections, translucency, transparency,
refraction, highlight, depth of field, and depth attenuation.

Supports multiprocessors and background processing.

Includes mathematically generated 3-D plants with seasonal variation, giving realistic plants, shadows, and reflections.

Works inside AutoCAD. Render changes to the model immediately. You never need to export or start over.

Progressive-refinement rendering algorithms with on-screen preview.

Save and restore plant, exposure, sun and sky, and environment settings.

Graphical library browsers for materials and plants.

RPC 3D Object support.

Post-processing for quick adjustment of brightness, Lighting Channels, fog, glare, and depth of field. 

Rendering with AutoCAD using nXtRender
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nXtRender for AutoCAD - Installation
Download
nXtRender can be downloaded from:

http://nxtrender.com/download/

Installation
After downloading nXtRender for AutoCAD, run the installation.

When you next start AutoCAD, type in the command: nXt

nXtRender Installation Video

 

Watch Video
www.youtube.com/watch?v=BrU4H64AsEI

In this Video, Daniel Hargreaves of AccuStudio will show you how to download and install nXtRender for rendering your
AutoCAD drawings.

nXtRender for AutoCAD is the rendering engine that allows you to easily create stunning, life-like images from your 3D
models inside AutoCAD and AutoCAD Architecture. nXtRender provides the highest quality in AutoCAD visualization solution
available today. 
Additional

FAQ
nXtRender does not load

I type nXt at the command prompt but nXtRender does not load. Instead AutoCAD produces the error message Unknown Command
"nXt".

Normally nXtRender registers its commands with AutoCAD during installation. On occasion, this mechanism may fail. In this
case you will need to manually load nXtRender the first time you run it in a particular version of AutoCAD. Use the following
procedure:

1. Type _appload at the command line. 
2. Navigate to the folder where nXtRender was installed. This is normally C:\Program Files\AccuRender nXt. 
3. Select one of the following files depending on your platform:

AccuRender nXt.arx -OR- AccuRender nXt64.arx (AutoCAD 2007 - 2009)
AccuRender nXt_18_.arx -OR- AccuRender nXt_18_64.arx (AutoCAD 2010 - 2012)
AccuRender nXt_19_.arx -OR- AccuRender nXt_19_64.arx (AutoCAD 2013 - 2015)

4. Press Load

Check the AutoCAD command line to verify that the application loaded without error. At this point you should be able to type
nxt or ar5 to launch the application. You should not have to repeat this procedure again for this version of AutoCAD. Simply
typing nxt or ar5 at the command prompt should cause nXtRender to load. You may need to repeat this procedure if you
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install another version of AutoCAD.
Rendering with AutoCAD using nXtRender
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nXtRender for AutoCAD - Licensing
30 day free Trial
nXtRender will run in full mode (no watermarks or limitations) for 30 days. After 30 days you will need to purchase a license
from:

http://nxtrender.com/purchase/

Licensing
Start AutoCAD and type in nXt

Use these click to bring up the license dialog:

Fill in the licensing information and click "Check License and Validate"

Licensing - 1.3
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and fill out the form, entering this license code, company name etc.

Click Check License and Validate to obtain an Authorization Code for your computer, for this application.

If, for some reason, you cannot use Validate Online to get your Auth Code: click Report Problem to email the validation
information to us, and we will send you an Auth Code by email.

(If you cannot send emails from this machine, you can click Copy, copy the information to the clipboard, paste it into a
document, transfer it to another machine and email it to us)

Rendering with AutoCAD using nXtRender
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nXtRender Tutorials and Videos
Rendering in AutoCAD 

Installation Video 

Lighting Basics Tutorial 

Interior Lights Tutorial 

Basic Materials Tutorial 

Chapter 2 - Tutorials and Videos
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Rendering with AutoCAD
nXtRender Installation Video

 

Watch Video
www.youtube.com/watch?v=BrU4H64AsEI

In this video, Daniel shows you how render your 3D model using AutoCAD and then how to get even better results using an
integrated add-on renderer nXtRender.

nXtRender (formally called AccuRender nXt) makes it easy to add lights, materials, trees, backgrounds, etc. to get a
professional rendering result quickly from your AutoCAD model. 
Additional
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nXtRender Installation Video
nXtRender Installation Video

 

Watch Video
www.youtube.com/watch?v=BrU4H64AsEI

In this Video, Daniel Hargreaves of AccuStudio will show you how to download and install nXtRender for rendering your
AutoCAD drawings.

nXtRender for AutoCAD is the rendering engine that allows you to easily create stunning, life-like images from your 3D
models inside AutoCAD and AutoCAD Architecture. nXtRender provides the highest quality in AutoCAD visualization solution
available today. 
Additional
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nXtRender Lighting Basics Tutorial
This Lighting Basics Tutorial will show you how to do basic lighting in nXtRender.

Lighting Basics Video
Lighting Basics Video

 

Watch Video
www.youtube.com/watch?v=A-u0z0XKn9k

In this Video, Daniel Hargreaves of AccuStudio will show you how to use the lighting defaults to create basic lighting conditions
for nXtRender while rendering your AutoCAD drawings.

Lighting Defaults make it easy to set the lighting parameters for interior scenes, exterior scenes, or to chose studio for
rendering of individual objects without having to know a lot about the details of lighting settings 
Additional

Lighting Basics Tutorial
Step 1 - Download Model

Download model from: AccuStudio

Load the model into AutoCAD and start nXt

Step 2 - Add a Ground Plane

Rendering with AutoCAD using nXtRender

Lighting Basics Tutorial - 2.3 - 14 -

http://www.youtube.com/watch?v=A-u0z0XKn9k
http://www.youtube.com/watch?v=A-u0z0XKn9k
http://www.youtube.com/watch?v=A-u0z0XKn9k
http://accustudio.com/workshop/video-tutorials/75-nxtrender-basic-lighting


Go to the Widget icon and select Groundplane.

You'll be able to put a plane under your model.

Step 3 - Render with Studio Lighting

Click the double Down Arrow on the Lighting Tab to expand the tab.
There are 4 preset lighting choices - Studio, Exterior, Daylight and Interior Lighting - select Studio.

Click the green car to start the rendering.

Let it run for about 100 passes.

Notice the subtle shadows under the eaves and on the ground.

Lighting Basics Tutorial - 2.3
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Step 4 - Change the lighting to exterior

This is a single source of light like the sun lets you change azimuth and altitude. We're going to stay with the default.

Click the green car and let the rendering run for about fifty passes.

We will explore the other two settings - Interior Daylight and Interior Lighting - in another Tutorial. They work best for interior
scenes with interior lights.

Step 5 - Use Model colors

Now let's explore changing the model to use model colors and studio lights

Go to the render setting, click on the double down arrow, scroll to the bottom and put a check mark nest to Use object color.

Go back to lighting, make sure studio lighting is set, and click the green car to begin the rendering process

Instead of an all-white model, nXtRender has loaded layer colors into the model. It will take more passes to get a good
rendering with colors.

Let it run for about 200 passes.

Rendering with AutoCAD using nXtRender
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Notice that the background is in white. This is because the model colors respond to the lighting.

Lighting Basics Tutorial - 2.3
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nXtRender Interior Lights Tutorial
This Tutorial will show you show you how to use the lighting defaults to create basic lighting conditions for nXtRender while
rendering your AutoCAD drawings.

Lighting Defaults make it easy to set the lighting parameters for interior scenes, exterior scenes, or to chose studio for
rendering of individual objects without having to know a lot about the details of lighting settings.

Interior Lights Video

 

Watch Video
www.youtube.com/watch?v=efA5Z-sPGpg

In this Video, Daniel will show you how to convert existing geometry in your model to lights, and to place new lamps into your
model using nXtRender for AutoCAD. 
Additional

Interior Lights Tutorial
Download Model

Download model from: AccuStudio

Load the model into AutoCAD and start nXt

Isolate Light Fixtures

Change your view, and turn off other layers to isolate the light objects.

This will make selecting the lights much easier.

Rendering with AutoCAD using nXtRender
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Select and Name Light Objects

There are two methods for creating lights. One is to create a light source and place it in the model. The other is to select an
existing object and give it light properties.

First, select an existing object and give it a name in this case ceiling light.

Continue picking the lights and giving them names

Mark Objects as Lights

Once they are all selected and named you can change the objects into lights by highlighting them, right clicking, and selecting
Properties.

Interior Lights Tutorial - 2.4
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You can set the wattage, or other properties as desired.

Render Scene with Lights

Turn all of your layers back on.

Select the Interior Lighting Default, and then click on the green car to begin the rendering.

A good rendering with lights can take many passes to complete.

Rendering with AutoCAD using nXtRender
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nXtRender Basic Materials Tutorial
This tutorial will show you how to create materials and use materials from libraries using nXtRender for AutoCAD. (formerly
AccuRender nXt)

Create a solid color material, create a material with a texture, select and place materials from libraries.

Creating and using Materials Video

 

Watch Video
www.youtube.com/watch?v=q0Dnl5Pnog4

In this Video, Daniel will show you how to create materials and use materials from libraries using nXtRender for AutoCAD.

Create a solid color material, create a material with a texture, select and place materials from libraries. 
Additional

Basic Materials Tutorial
Download Model

You can download sample models for this video from accustudio.com/workshop/models

Load the model into AutoCAD and launch nXtRender (type nXt)

Materials Tab

Click the double down arrow for materials and you'll see there's a small toolbar. We're going to focus on the first few icons.

You can either create a new material, or load one from an existing source.

Create New Material

Click the down arrow next to little purple sphere there several material choices.

Start with solid color.

Rendering with AutoCAD using nXtRender
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This brings up the basic material dialog box

Click on the gray or colored square. This brings up the color wheel.

nXtRender Basic Materials Tutorial - 2.5
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Click in the color box you'll see that the material changes in real time.

So you have a general idea with a look like in your model.

Create a Textured Material

Click on the textured icon it brings up a dialog boxes select a bitmap.

Set the Scale of the bitmap.

Rendering with AutoCAD using nXtRender
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The scale should reflect the real world size that you need for your bitmap.

Set as Bump Map

Click the Advanced button to load the Advanced Material Editor.

Click the Texture Tab.

Set the Bump Map value to 2.5.

This will increase the 3D effect of the textured material.

Use Saved or Library Material

nXtRender Basic Materials Tutorial - 2.5
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Click the Open icon to select a materiel from the disk.

You can download pre-made materials from nXtRender:

www.accurender.com/page/material-libraries

or from AccuStudio.

[www.accustudio.com/exchange/materials

Download some materials, and select one from the disk.

There are two ways to place materials with nXtRender.

Drag and Drop a Material

Drag a material from the material browser to an object in AutoCAD.

Rendering with AutoCAD using nXtRender
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Hover over the object and choose placement by layer or by object.

Placement by layer will assign the material to all objects that are on the layer.

Render Model

After you finish assigning the materials, render a view of te model.

Let it run for about fifteen passes with daylight presets.

If you happy with the materials,then render any view you like.

nXtRender Basic Materials Tutorial - 2.5
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Multipass rendering Video
Mutli Pass Rendering Technology Video

 

Watch Video
www.youtube.com/watch?v=3o1oJv5l9Do

This video, taken from a Webinar for the nXtRender/IRender/AccuRender nXt Engine explains some of the advantages of
multi-pass rendering. 
Multi Pass rendering lets you quickly see what your rendering is going to look like – after the first few passes – and the either
change settings, or let the rendering continue go get better.

In this video Scott Davidson shows you how multi-pass rendering works for nXtRender for AutoCAD, Revit or SketchUp.

Rendering with AutoCAD using nXtRender
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nXtRender The Basics
Get Started with rendering, lights and materials.

 
Apartamento en Los Naranjos by Alejandro Testa
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Rendering
Starting and Stopping a Rendering
Click the Render AutoCAD Viewport button on the palette to initiate a rendering of the current AutoCAD viewport:

By default, the rendering process will continue refining the image, pass by pass, until you tell it to stop by pressing the Stop
Rendering button. This allows you to manage the trade-off between time and quality. The longer you allow the rendering to
continue, the more closely it will resemble its fully-converged or "correct" result. You can stop a rendering after seconds,
minutes, hours or days. It's entirely up to you.

Pressing the Pause Rendering button once will suspend the rendering after the current pass is completed. Pressing the same
button again will cause the rendering to terminate as soon as possible. A suspended rendering can pick up where it left off by
using the Continue button. Pressing the Close button on the window frame immediately terminates the rendering and closes
the display.

You can continue to work in AutoCAD while a rendering is active, by pressing the Minimize button on the nXtRender display.
The display can be restored at any time by pressing the Show Current Rendering button, or by using the Windows Taskbar.

Additional Notes
nXtRender produces images by using real world luminance values. The process of converting luminance values to
displayable pixels is called Tone Mapping .
Here are some suggested number of passes for a satisfactory result under a few different scenarios (your actual
results may vary):

Default exterior scenes, 10-15 passes
Exteriors with indirect lighting, 25-50 passes
Interior artificial light simulations, 25 passes per set of 8 lights
Interior daylight simulations, 50-100 passes
Studio models, 10-15 passes

If you do not want your rendering to continue indefinitely, you can use the Passes setting on the Render Settings tab
to set an automatic stopping point. A Passes setting of 0, the default, means continue indefinitely until manual
terrmination.
An Autosave option is provided in the Render Settings tab to force nXtRender to save your rendering periodically. This
may result in usable work even after a power outage has interrupted the process. See Saving your Rendering, below.
The status bar at the bottom of the nXtRender display shows mouse-over information about each pixel in the
rendering, including the RGB value (luminance) and the resulting color after tone-mapping.

Rendering Resolution
Set the rendering resolution in the Render Settings tab of the nXtRender palette. The Total Pixels option is an easy way to
match the AutoCAD viewport exactly. The default setting of 300,000 pixels provides a good setting for doing proofs or images
destined for the web. 3,000,000 pixels or more may be required for a final, printed, image.

Processing time and memory usage are directly (linearly) related to the total number of pixels in your rendering. The higher
the resolution, the longer the rendering will take and the more memory it will require.

Saving Your Rendering
The Save Rendering button allows you to save your rendering to several different image formats. You can save to most
formats while a rendering is in progress.

The Alpha channel versions of the file formats are meant to be used for high-quality compositing. Backgrounds will appear

Rendering with AutoCAD using nXtRender
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black when the rendering is saved with Alpha channel.

The .hdr and .exr formats store luminance data directly in a High Dynamic Range format. Non-luminance backgrounds, such
as normal photographs, will appear black when saved in one of these formats.

The .nXtImage format is the native image format of the nXtRender rendering. It is the recommended format for storing your
renderings, since it preserves the most information about your rendering. Images stored in this format can be manipulated in
the nXt Image Editor and special FX can be added. From this editor, you can save to many popular standard formats,
including all of the formats supported in nXtRender. You can also save to Piranesi (.epx) file format.

Rendering - 3.1
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nXtRender Tone Mapping
Tone mapping is the process of converting the luminance data used by nXtRender into displayable or printable RGB pixels.

As you move your cursor over the nXtRender Rendering screen, notice the numbers on the status bar. The Value fields show
the actual data in the nXtRender image for the Red, Green, and Blue sub-channels. The data is luminance, in units of
candelas per meter squared (cd/m^2). The first three Color fields show the resulting RGB colors produced after tone-
mapping, and displayed in the image. (The fourth Color field shows the Alpha, or transparency channel, which is used for
composting.)

The tone-mapping controls are located in the upper right corner of the render screen.

Brightness - The Brightness control is the most important.

Adjusts the overall brightness. For example, if a white surface in your model is rendering gray, you can increase the
brightness until the surface appears white. Or, if your exterior scene seems overexposed, you can decrease the
brightness until the scene appears more correct.

The default setting is 100 — smaller numbers produce darker images. For most renderings, small changes produce
noticeable effects.

Burn - Burn changes the white point of the image so that less than max brightness objects will map to white.

See: Using Burn

Saturation - Controls the amount of color included in the rendering.

Slide it to the left to create a gray image.

Rendering with AutoCAD using nXtRender
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nXtRender Color Maps
The Color' of each material is used as the Base Color for rendering - matte reflection and transparency.

Color Settings for a new Solid Color Material

 

RGB Color

Computers use RGB color values to project color onto the monitor. Each pixel on the monitor can display a combination of
these three colors to display the desired result. The same color definitions are also used for other outputs - such as printing.

In nXtRender we describe base colors using RGB, and then the colors are modified while rendering based on lighting,
reflections from other surfaces, etc. Colors with textures usually use the colors in the texture image. However the Base Color
can be blended with the texture if desired.

Color Maps - 3.3
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Adding and assigning materials
Material Basics
Adding Materials to a Drawing

Materials can be added to your drawing in many ways. Here are a few:

Creating a new material

You can create a new material by using the dropdown button on the Materials tab of the nXtRender Palette. Choose
the appropriate template for your material. The appropriate Material Editor will be invoked. This material is stored in
the current drawing only.

Load material from disk or library

Using the Get Material from File button on the Materials Tab, you can import .nXtMaterial files for use in the current
drawing. Many material files are available for Download .

Drop material from Windows File Explorer

You can drag and drop an .nXtMaterial file directly from explorer into your AutoCAD drawing.

Dropping a material from Windows File Explorer onto an object in AutoCAD: 

Rendering with AutoCAD using nXtRender
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You are asked whether to assign the material by layer or directly to the object, and also the material is added to the active
material list in the nXtRender control panel.

Assigning Materials to Objects and Layers

Materials can be assigned to objects or layers in your drawing. If you use AutoCAD Architecture(r) (formerly Architectural
Desktop(r) or ADT) you can also assign materials to AEC components.

There are many ways to assign a material to an object or layer. Here are a few:

Drag and drop a material from the palette onto an object. You will have the choice of assigning the material to the
object or two the object's layer.
Select the material in question and use the Attach Material to Objects button. This method allows you to assign
materials to individual faces of 3dsolids by using AutoCAD's sub-object selection methods.

Adding and assigning materials - 3.4
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Drag and drop a material from the palette onto a layer in the Layer list.
Select a material from the palette. Select one or more layers from the layer list. Click the Attach Material to Layer
button.

Drag and drop the material file from Explorer directly onto an object in your drawing. This method allows you to add
and assign a material in one operation. You will be prompted to choose the object or the object's layer.

Assigning Materials to ACA Components

nXtRender materials are just AutoCAD materials with some additional data attached to them. If you use AutoCAD
Architecture (ACA) you can attach an nXtRender material in the same way you would attach an AutoCAD native material.
For example, using Style Manager, you can attach an nXtRender material to an AEC material using the following procedure:

Select your material under Multi-Purpose Objects->Material Definitions.
On the Display Poperties tab, click the Edit Display Properties button.
Use the Render Material popdown list to select your nXtRender material. The nXtRender materials will have a prefix of
"AccuRender-" before the material name.

Rendering with AutoCAD using nXtRender
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Video Tutorial
Creating and using Materials Video

 

Watch Video
www.youtube.com/watch?v=q0Dnl5Pnog4

In this Video, Daniel will show you how to create materials and use materials from libraries using nXtRender for AutoCAD.

Create a solid color material, create a material with a texture, select and place materials from libraries. 
Additional

Additional Notes

Adding and assigning materials - 3.4
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Use the AutoCAD _PURGE command to delete unwanted, unused materials from your drawing. Materials in use cannot
be deleted.
Material assignments by object take precedence over material assignments by layer.
Use the Remove Material from Objects button to remove materials assigned by object.
To remove a material assigned by layer, select the layer(s) from the Layer list and click Remove Material from Layers

Rendering with AutoCAD using nXtRender
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nXtRender Lighting
nXtRender is designed to simulate real-world lighting. Use the following guidelines when lighting your model:

Provide accurate information whenever possible. Avoid using unrealistic intensity levels for light sources.
Set the units correctly for your drawing by using the AutoCAD _UNITS command. The lighting will not be correct
unless the units are correct. For example, if your drawing is in millimeters, make sure that millimeters is
specified.
Adjust the overall brightness of your rendering by using the Brightness control on the rendering display. Do not
attempt to adjust the overall scene brightness by changing the intensity of all of the light sources. nXtRender's
automatic exposure adjustment will be working against you if you attempt to do this.

Lighting Presets

nXtRender provides four lighting presets which can help get you started when deciding how to light your model. There are
many more lighting options available, but the presets are often sufficient for many different renderings. The Presets popdown
list is available on the Lighting tab of the nXtRender palette. Choose the Preset which most closely resembles your scene:

Studio mimics the lighting which might be found in a photographer's studio. It is most useful for rendering small
to medium sized objects in isolation.
Exterior is used for daylight simulations of architectural exteriors. A sun and natural sky are simulated.
Interior Daylight allows you to simulate an architectural interior during the day, lit by natural light.
Interior Lighting provides a simulation of an architectural interior at night, lit by artificial luminaires.

Studio
The primary lighting is provided by an high dynamic range image file (HDRI). The light from the HDRI has been artificially
dimmed, to resemble the interior lighting levels of the studio. You can modify the HDRI settings and file on the Sky tab. You
can add artificial lights to your scene using the Lights tab. The visible background in the Studio preset is black.

Exterior
The sun and sky settings can be modified on the Sun tab. You can specify sun angles directly or you can use geographical
location and date and time. The default visible background for this preset is the simulated sky.

Interior Daylight
Use Interior Lights as well as sun and sky for lighting.

For an interior daylight simulation to work properly, you must use a transparent material to represent the glass in your
windows. Sun and sky settings are similar to the Exterior preset.
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Also, you must add artificial lights to your model.

See: The Lights Tab

Interior Lighting
Use Interior Lights only.

For Interior Lighting to work properly, you must add artificial lights to your model.

See: The Lights Tab

Additional Notes on Presets
Indirect lighting, the lighting reflected off of surfaces, is on when one of the two interior presets are selected
and off for studio and exterior. This type of lighting is a very significant component of an interior simulation.
For exteriors and studio models the effects of indirect lighting is more subtle. You can turn on indirect lighting
for exteriors and studio models if you want this additional realism (at a substantial performance cost.)
Interior daylight mode and exterior mode do not have artificial lights enabled. You can add artificial lights to
these presets if you wish by following the procedure here.
Night time renderings can be a little tricky. See this to get started.

Tutorials
See: nXtRender Lighting Basics Tutorial
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Adding lights
Adding Lights to Your Model

Use the following procedure to add an artificial light to your drawing:

Draw and position the object which will serve as your light source. Once this object is tagged as a light source, it will
emit light in the pattern you choose.
Use the New Light dropdown button on nXt's Lighting tab to select a pattern for your light. Four patterns are available:

//Omnidirectional// distributes light in all directions equally.
The //Spot// pattern provides a beam which you can focus.
//Diffuse// provides an approximation of a recessed light with a diffuser or baffles.
The //Photometric// pattern allows you to use a manufacturer's .ies goniometry file to describe the distribution.

When prompted select your object (the Photometric pattern will first prompt you for your .ies file.)
Provide a name for your light.
Hit enter to accept default values for the other prompts.

Additional Notes:
By default, all lights will direct their light straight down. Depending on your scene, you may need to aim your light in a
different direction. Before you begin the aiming process, it is often easier to have a target object to snap to. Right click
on the light in the list, and select Aim < to aim your light. The different patterns will have different prompts to follow.
To change the properties of your light, right click on the light in the list and select Properties.
Click here for additional information on IES (Photometric) lights.
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Working with Plants
Working with Plants
nXtRender includes a fun and powerful plant generator which efficiently generates complex entourage objects during
rendering. These plants have little impact on drawing size; only a place-holder is kept in AutoCAD.

Two broad categories of plants are included. Tree-like plants (including shrubs and houseplants) are distinct objects which are
inserted in specific locations. In addition, an existing AutoCAD object can be tagged as groundcover to make it appear to
sprout when rendered.

Creating Plants
Run nXtPlantEditor64.exe or nXtPlantEditor64.exe from the nXt folder in Program files to load the Plant Editor

Tree Editor usage
Plant Type

Set the type from the File/New menu at the top. 

 

There are four tree types - Standard, Conifer, Broad Crown, Palm  and Complex 
(Do not use Groundcover with RpTreeMaker).
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Each has different setting on the tabs of the tree editor.

Play with the various settings to see what they do.

Trunk Settings
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Change the Parameters and see the results at the left.

Foliage and Flowers

[[Image:Tree-editor-foliage.jpg|500px]

You can click on the leaf image to select a different image.

Flowers/Fruit 
You can also add an image to be used as flowers or fruit 

Leaf and Flower Images

You can select new leaves, trunk, etc. by clicking on the image.

You can also add your own leaves and bark to the Plant Image folder and use them for your custom trees.
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RayTrace

Click 'Start' on the RayTrace drop down menu to see a sample rendering of the tree with foliage.

Use the mouse and scroll-wheel to on the image to set a new view before starting rendering if desired.
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Obtaining nXtRender Plants

nXtRender comes with a full-featured, easy to use, Plant Editor which enables you to create your own plants. The Plant Editor
is located in the Windows Start menu, under the folder nXt.

There are also several online sources for nXtRender plants, including the Plant Library and Mixed-Content Library sections of
the main nXtRender website:

http://www.accurender.com/page/content-and-entourage

To Insert an nXtRender Plant:

Select Widgets->Plants->Add... from the nXtRender palette menu bar

Select the .ArPlant file you want to insert
Pick a Location for your plant in the drawing
Cancel or pick additional Locations for additional instances of the same plant

To Tag an object as nXtRender Groundcover:

Select Widgets->Plants->Add Groundcover from the nXtRender palette menu bar
Select the .ArGroundcover file you want to insert
Select the object to tag

If you tag a 3D Solid object as groundcover, the groundcover will take on a "topiary-like" appearance.

Additional notes on nXtRender Plants

Make sure the units are set correctly for your drawing. The AutoCAD _UNITS command or _INSUNITS system variable
controls this.
nXtRender Plants can be scaled, copied, and rotated.
Widgets->Plants->Randomize allows you to select a group of plants and randomize their scales and rotations
Widgets->Plants->Id tells you the name of a previously inserted plant
Widgets->Plants->Remove Groundcover allows you to "untag" an object previously tagged as groundcover.
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nXtRender Beyond the Basics
Help in working with textures, decal, HDRI skies, RPC objects, etc

 
HDRi Sky for illumination and reflection.

 
Livingroom by Jan Verzelen

Chapter 4 - Beyond the Basics

- 47 - Chapter 4 - Beyond the Basics



Working with textures
Working With Textures Textures allow the user to map image files onto the surface of a material. There are three ways to do
this.

1. For a simple texture mapping, go to Materials → New Material → Textured… You will be prompted to select an image to
map to the surface of your material. If the image does not tile well, you can select Mirror Tiles to remove the seams.

2. For a more sophisticated textured material, go to Materials → New Material → Texture Set… This allows you to import
third-party texture maps that contain information such as displacement, normal, or bump maps. Displacement maps
cause the material to have depth, which comes at a performance cost. For the appearance of relief without this
performance cost, use normal or bump maps.

3. For advanced options, either click the Advanced… button in the Texture Set dialog, or go to Materials → New Material →
Advanced… and then click on the Texture Maps tab. This interface allows you to control more details, such as the
height of the displacement mapping or which colors are masked. It also allows you to add maps and manually set the
map type, e.g. Standard, or Displacement. For more information about advanced options, click here.

Non-tiling textures can also be applied directly to objects, bypassing the material altogether, by using decals. Working With
Textures
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Working with decals
Working with decals

Decals are non-tiling image maps which you apply directly to objects (instead of indirectly via the object's material.) Decals
can be used to represent a variety of visual phenomena, including a painting hung on the wall, labels on jars, printed signs,
images on monitors, etc.

Use the following steps to apply a decal to an object:

1. Expand the Object Properties tab on the nXt Palette
2. Select the object
3. Right-click on the Decals list and select New
4. Select either Planar or Cylindrical Decal as appropriate
5. Follow the prompts at the command line (make sure to Accept the decal by pressing Enter when finished)

The decal will appear in the list anytime the object is selected.

To remove a decal from an object:

1. Expand the Object Properties tab on the nXt Palette
2. Select the object
3. Right click on the decal you wish to remove
4. Select Remove

The decal will no longer appear in the list when the object is selected

To reposition an existing decal:

1. Expand the Object Properties tab on the nXt Palette
2. Select the object
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3. Right click on the decal you wish to reposition
4. Select Edit Position and Orientation
5. Follow the prompts to reposition (make sure to Accept the decal by pressing Enter when finished)

To change the surface properties of a decal:

1. Expand the Object Properties tab on the nXt Palette
2. Select the object
3. Right click on the decal you wish to edit
4. Select Properties…

The Decal Properties dialog box will appear allowing you to change many of the surface properties of your decal.
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Working with Reflection Shaders
Working with Reflection Shaders in the Advanced Material Editor

Shaders allow you to change the algorithm used by nXtRender when it calculates reflections. The default (Balanced) shader is
the best choice for most materials. However there are times when another choice might offer better performance, converge
faster, or produce fewer artifacts in the process.

Many of the shaders deal specifically with how artificial light sources are reflected in a material. There are two fundamental
algorithms used by nXtRender to calculate these reflections. The first is a "ray casting" algorithm and the second is a
"highlight" algorithm. These two algorithms are mathematically equivalent and will eventually produce identical results.

Reflection Shader choices in nXtRender are:

Balanced. This is the default shader and is the correct choice for most situations. nXtRender automatically balances
the two algorithms based on the Sharpness of the reflection.
Glossy. This shader increases the blurriness of the reflection and prevents ray-casting entirely. No object or light
reflections are calculated. Use this shader to increase performance and prevent artifacts for materials with very blurry
reflections. Some reflective subtlety may be lost.
No Light Source Reflections. This shader excludes ray-casted reflections of light sources. This is sometimes useful in
preventing "speckle" artifacts if your material is blurry and your scene contains small, bright, light sources.
No Light Source Reflections and No Highlights. This option excludes all reflections of artificial light sources. Object
reflections are still calculated.
No Highlights. Only raycasting is used to calculate reflections of light sources. This shader is useful when light sources
are large and the surface in question is not too blurry. In these cases, the highlight calculation can take a long time to
resolve.
Monte Carlo. Only raycasting is used to calculate reflections of light sources. The raycasting occurs in an initially very
noisy way, and gradually converges to the correct solution. It is most useful when the surface is not too blurry. Both
convergence and frame rate may slow when using this option.
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Adding indirect lighting to an exterior rendering
Adding Indirect Lighting to an Exterior Rendering - using the effect of lighting reflected from other surfaces - can add some
subtlety and realism to your exterior rendering. In particular, the undersides of overhanging features such as eaves or
balconies can be rendered more accurately when using indirect lighting.

This subtlety, however, comes at a substantial performance cost. More passes will be required to resolve the image, and each
pass will take longer.

Use the following steps to enable indirect lighting for your exterior rendering:

1. On the Lighting tab, select the Exterior preset.
2. Check Show Advanced Tab.
3. On the Advanced Tab, change Indirect from Off to Exterior.
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Combining daylighting and artificial lighting for an interior
rendering
By default, nXtRender's Interior Daylight preset does not allow you to add artificial lights. To combine both types of lighting
use the following steps:

1. Select the Interior Daylight preset on the Lighting Tab.
2. Check Show Advanced Tab
3. On the Advanced Tab, change Lights from Off to On. The Lights Tab will appear and allow you to add lights to your

model.

Additional Notes:

Use accurate values for your lights, daylight settings, and window glass if possible.

Because the sun and sky are very much brighter than most lights, you may not see a lot of effect from adding artificial
lighting to your daylit scene. This is normal. Avoid the temptation to artificially boost the power of your light sources. It
is legitimate to turn the sun and sky down somewhat, as these are based on a clear, unimpeded sky. A multi-channel
rendering may help you get the picture you want, while still preserving accurate data.
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Working with HDRIs
High dynamic range images (HDRIs) are 2D image files which contain a much broader range of values than what is normally
found in a standard image file, such as a .jpg or .png. When these images are produced using a spherical projection, they
can be used to light models. If the values contained in the HDR are accurate, then the lighting will be accurate. (See below for
more information on units.)

HDRIs can be used in nXtRender in many different ways. Two common uses for HDRI lighting are architectural (lighting a
building exterior) and studio (lighting a product using HDRI for ambient):

Using an HDRI to Light an Architectural Exterior

On the Lighting Tab, select the Exterior Preset.
Check Show Advanced Tab.
On the Advanced Tab, turn the Sun Off.
On the Advanced Tab, change the Sky from Auto to HDRI
At this point you can choose a specific HDRI using the Sky Tab.

This procedure uses the HDRI as a visible background to your rendering. This may require a high-resolution HDRI to avoid
pixellation artifacts.

HDRi sky used for visual background, illumination and reflection:

Using an HDRI to Simulate Studio Lighting

On the Lighting Tab, select the Studio Preset.
Choose a specific HDRI using the Sky Tab.

This option uses a black background instead of visualizing the HDRI directly. It also reduces the intensity of the HDRI by a
factor of 20X to simulate indoor lighting conditions. ---

Additional Notes
nXtRender assumes that HDRIs contain radiance values expressed in units of watts. All of the HDRIs available via our
website are built this way unless otherwise noted. However, this is often not the case with HDRIs from other sources.
The units in many HDRIs are not calibrated to real-world units of any sort. The intensity of these HDRIs may need to
be adjusted in order to achieve proper illumination levels. See the section on calibration below.
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There are many different ways to use HDRIs in nXt. In addition to the Sky, a different HDRI can be used for each of
the three background channels: Visible, Reflected, and Refracted Background. Use the Backgrounds Tab, Channel
control to individually control each channel.

Calibrating an HDRI sky

Create a new model in AutoCAD and load nXtRender
Select the Exterior lighting preset
On the Advanced Tab, change the Sky to HDRI
On the Sky Tab select your HDRI
Start WalkAbout
Change the projection to Panorama
Press render and stop the rendering after one or two passes. What you now have is a rendering of your entire HDRI.
Move the cursor over the image while observing the Value of each pixel on the status line. The units are cd/m^2. You
can zoom in on the image if required to examine smaller sections in more detail. Here are some guidelines to help
you determine if the map needs scaling:

The average value for a clear sky is approximately 8000 cd/m^2
The average value for an overcast sky is approximately 2000 cd/m^2
The area around the sun can be quite bright. Values of 100000 cd/m^2 or more are not unreasonable. The
solar disk itself can be much brighter than this.
For night scenes, light sources themselves are bright. Values of 3000 to 5000 cd/m^2 are not uncommon for
streetlamps. The luminance of the moon is 2500 cd/m^2. Other objects should be quite dark. Value < 1
cd/m^2 are common for objects lit only by environmental light.

If you decide that your HDRI would benefit from scaling, use the Intensity setting on the Sky tab to enter your scale factor.
Repeat the rendering above to validate your new setting. Alternatively, you can use Lighting Channels to adjust the lighting
more interactively.
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nXtRender Lighting Channels
Lighting Channels allow you to adjust many aspects of the lighting in your rendered image in real-time, after the rendering
has been produced. This is accomplished by allowing you to create up to 8 lighting "channels" in the image. Each light source
in the drawing, including the sun and sky, can be assigned to a channel. Once this image is rendered and saved, each
channel can be individually scaled in the Image Editor . For example, using this capability, you can produce day and night
interiors with a single rendering. The following five steps are necessary to produce and manipulate a multi-channel image:

You must tell nXtRender how many channels you want. Go to Lighting->Advanced->Channels and set the number
desired from 1 to 8. Each additional channel you add requires an additional 12 bytes per pixel internally. This is a lot
of memory, particularly for high resolution renderings. It may not be possible to complete your rendering on a 32 bit
system.

You must turn on all of the participating lights. Lights which are off will not contribute to the image and will not be
scalable. Because you are rendering with more lights, it may take a little longer. For example, to create an interior
image which contains both natural and artificial lights:
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1. Select the Interior Daylight preset.
2. Select Lighting->Advanced->Lights->On

You must tell each light source which channel it belongs to. By default, Sun and Sky are set to channel 0, artificial
lights to channel 1. There are controls for each light source, including sun and sky. Valid channels are 0-7.

Lighting Channel Names
Lighting Channel Names make it easier to know which channels you are modifying in the nXtImage Editor.

Right click on a light, select Properties, The type in a name, after, or instead of a channel number.

Adjusting Lighting Channels

After rendering, you can modify the intensity of lights in each channel by clicking Channels in the rendering window.
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As you adjust the channels, the tone-operator will compensate. All of the tone mapping controls and rules still apply. For
example, if you're trying to do a night and day exterior using the same rendering, you will almost certainly need to adjust the
tone-op brightness down for the night time scene.

Lighting Channels - 4.7

- 59 - Lighting Channels - 4.7



Using IES (photometric) lights
IES files (.ies) are photometry files which define the distribution of light from a light source. These files are often provided by
luminaire manufacturers. By using the IES file to define your distribution, rather than one of the standard distributions
available (i.e. omni-directional, diffuse, spot), you can more accurately depict your luminaire. In addition, the IES file can also
be used to define the intensity of your luminaire.

Use the following steps to attach an IES file distribution to a light source:

Create the light in the usual way.
Right click on the light in the list and select Properties... from the menu
Change the Light Pattern to Goniometry File
Click the Browse... button and select the .ies file.
Normally you will want to use the file to define the intensity of the source as well. Click the From File checkbox under
Brightness to do this.

Additional Notes:

The vast majority of IES files are known as "Type C" goniometry files. These are supported by nXt. Type A files are
occasionally used by the automobile industry to define headlights, and type B files are sometimes used to define
floodlighting. Type A and B are not supported in nXt.
IES distributions already include the effects of luminaire elements such as baffles, reflectors, and diffusers. It is
important to exclude these elements from the calculation by properly tagging the non-source parts of your luminaire.
IES distributions are often assymetrical, so the process of aiming the source includes not just a target, but a rotation
angle as well.
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nXtRender Rendering Engines
There are three rendering engines. - Packet Mode, the Path Tracer, and the Hybrid Engine.

Packet Mode is the fastest for creating quick renderings. I does this by taking some shortcuts on how light, reflection and
transparency are processed. The other engines use a more precise algorithm to process the end result for each pixel, but
start out with a rough looking image for the first 100 or more passes until the various calculations for adjacent pixels start to
converge.

Rendering Engines
Packet Mode

 
Packet Mode after 68 passes

The Packet Mode rendering engine provides high quality renderings quickly by approximating some things light lighting and
reflection using 'packets'. Processes packets of rays. This produces a very good rendering in the shortest time.

The Packet Mode processes packets of rays, while the Path Tracer and Hybrid Engine process individual light paths.

Because of some shortcuts, such as Daylight Portals, and other aspects of the rendering process, Packet Mode create a
usable image in fewer passes. Path Tracer often requires more passes before the image gets smooth.

Path Tracer
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Path Tracer after 1500 passes.

The Path Tracer processes individual light paths This requires more passes, but produces better results.

The Path Tracer can provide a better quality finished product for many models (with a simpler setup), but does so at the
expense of a more complex and time-consuming calculation. The Path Tracer begins by displaying a very grainy or "noisy"
image which gradually refines and becomes smooth. This process is known as convergence. Some scenes will converge very
quickly, others will take many hours.

The Hybrid Engine
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Hybrid Engine ater 625 passes.

The Hybrid Engineis faster per pass than the Path Tracer, and has special processing of Caustics for transparent and reflective
surfaces.

This water scene was rendered for 625 passes - nine hours - with the Hybrid Engine:

Rendering Speed
In many cases individual passes in Path Tracer or the Hybrid Engine are faster than Packet Mode, however the overall
rendering process may take longer to complete, because you will often need many, many more passes to achieve a good
result.

As 16-core (or more) processors become available, then it will make more sense to use a many, many pass rendering
solution.

Additional Notes
In general, images rendered using the Path Tracer will take longer to converge than images rendered using the
Standard method. Interior daylight simulations, particularly those scenes where the windows are relatively small, may
take much longer. On the other hand, the Path Tracer is less sensitive to instancing, plants, and displacement maps.
Models which rely heavily on these features may actually converge faster using the Path Tracer.
The standard Packet Tracer algorithm produces a very high-quality simulation. For many models, the difference in
quality between the Packet Tracer method and the Path Tracer can be very subtle, particularly if indirect lighting is
enabled. The difference in quality may not be worth the extra processing time.
The Path Tracer is almost always easier to configure and set up than the Packet Tracer method. Advanced settings
such as reflection shaders, daylight portals, and ambient lighting, are not used when the Path Tracer engine is
selected.
Certain advanced effects, such as caustics or blurry transmission, can be calculated with better accuracy using the Path
Tracer.

Slower Convergence
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Because of some shortcuts, such as Daylight Portals , and other aspects of the rendering process, Packet Mode create a
usable image in fewer passes. Path Tracer often requires more passes before the image gets smooth. In many cases
individual passes in Path Tracer are faster, however the overall rendering process may take longer to complete.
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Controlling tesselation-- smoothing curved objects
nXtRender approximates curved solids with meshes. You can control the density of these meshes by using a combination of
AutoCAD's _FACETRES system variable and the Tesselation setting on nXtRender's Object Properties tab. These two values act
together. The product of the two determine the density of the mesh. Higher values produce denser meshes. These will appear
smoother, but will require more memory and rendering time.

 

Additional Notes

_FACETRES operates globally and will affect all curved objects in your drawing. The Tesselation property can be
applied to individual objects. The Tesselation property is used by nXtRender only and does not affect the
AutoCAD display.
nXtRender does not respond to _VIEWRES except for the WalkAbout display.
See AutoCAD Help for more information on _FACETRES and _VIEWRES.
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Using Archvision RPC with nXtRender
RPCs (®) are image-based "entourage" objects which can be inserted into your drawing and rendered. Popular RPC objects
include people, cars, and plants. Some RPCs are 2D "cutout" objects which automatically orient themselves to a view. Others
are 3D textured models.

RPC Car rendering with nXtRender

In order to use ArchVision RPCs in nXtRender you must download and install the plugin for Autodesk AutoCAD / AutoCAD
Architecture from ArchVision's website. Be sure to install the version of the plugin which most closely corresponds to your
version of AutoCAD or ACA. The plugin provides an interface within AutoCAD for downloading, inserting, and editing content.

Additional Notes

Always use the RPC's "Cast Reflections" switch when working in nXtRender. Shadows and reflections will not be correct
unless this switch is set.
A "post-process" plugin is also available for Adobe Photoshop(r). Since RPCs are prelit, better results can often be
obtained by inserting them into finished renderings.
Piranesi (®) also offers direct support for RPCs
RPCs inserted into AutoCAD also work properly with the AutoCAD native _RENDER command.
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Using Textured Mesh Files (3DS or OBJ) with nXtRender
nXtRender allows you to import meshes with texture coordinates welded to the vertices. These types of meshes are commonly
used for "entourage" objects, such as 3D people or plants. Many different software packages can create these meshes, and
many ready-made objects are available online. Current file support includes .obj and .3ds. This feature is not available in
AutoCAD 2007.

To Import a Textured Mesh Object:
Make sure your mesh file, its material library (if .obj), and any texture files are located in the same folder.
From the Widgets menu, select Textured Mesh Objects->Add...
When prompted, pick a location for the objects.

Your object, its materials, and its textures will all be imported.

Additional Notes:
AutoCAD may have trouble dealing with large meshes. It is strongly suggested that you set
_SELECTIONPREVIEW to 0 when dealing with these, since the selection preview mechanism does not work well
with large meshes.
Most mesh objects can be exploded once into individual meshes.
You may need to scale the mesh once inserted.
These meshes are nXtRender custom objects. Make sure nXtRender is loaded when converting a drawing from
2010 format to 2007 format. These will be proxy objects when nXtRender is not present.
A single grip and object snap point is provided. Osnap responds to "insert" or "nearest".

Textured mesh objects are stored as nXtRender custom obejcts. They can be moved, scaled, copied, deleted-- but they
cannot be otherwise edited and different materials cannot be assigned to different meshes. Using the procedure below, you
can convert this custom nXtRender object to one or more native AutoCAD "polyface" meshes. If you do this, you will lose the
vertex texture coordinate information. This is generally not advised for objects with complex texture mapping such as people
or plants. However, it may be advantageous to do this for other models, such as furniture. Once converted, you can use
native AutoCAD editing tools, materials and mapping assignments, etc..

To Convert a Textured Mesh Object:

From the Widgets menu, select Textured Mesh Objects->Convert to AutoCAD Mesh <
Select the custom objects you would like to convert

Additional Notes:

Meshes in AutoCAD are limited to 65,535 vertices. Any mesh which exceeds that limitation will not survive the
conversion process. This is not a problem with the 3ds format, which shares the same limitation, but may be a
problem for obj meshes.
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nXtRender Lighting Palette
Use the Lighting Palette to enter information about the sun, sky or artificial lights.

Lighting effects the brightness and shading of objects in you model, and is used for highlight reflections on shiny surfaces.

 
Image by kingjin
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The Sun Tab
The Sun tab contains the controls for altering the parameters of the automatic sky preset. The sun is a directional light source
infinitely far from the model. The controls for the sun specify its direction using spherical coordinates.

Azimuth is a measure of horizontal rotation clockwise from north.
Altitude is a measure of vertical rotation up and down, where zero is at the horizon.

By checking the Specify Angles Directly box, these values can be input manually. The other option is for nXtRender to
automatically calculate the correct angles based on date, time, and location information.

Other sky settings in the Sun tab are:

Cloudiness
Sun Intensity
Sun Highlight
Sun Channel
Sky Intensity
Skylight Saturation
Sky Channel
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The Sky Tab
The Sky Tab allows the user to use a high dynamic range image (HDRI) for lighting. For more information on how this is
done, click here: Working with HDRIs

The Sky Tab only appears when Studio Lighting Preset is selected.

File:NXtRender Sky Tab.jpg 300px 

HDRi Parameters
Intensity
Saturation - 0.0 for grey scale, 1.0 for full color

For interior scenes, set to 0.0 so illumination from windows is not colored.

Channel - Lighting for the Channel for the Sky
Blur
Angle
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The Lights Tab

Use the following procedure to add an artificial light to your drawing:

Draw and position the object which will serve as your light source. Once this object is tagged as a light source, it will
emit light in the pattern you choose.
Use the New Light dropdown button on nXtRender's Lighting tab to select a pattern for your light. Four patterns are
available:

Omnidirectional distributes light in all directions equally.
The Spot pattern provides a beam which you can focus.
Diffuse provides an approximation of a recessed light with a diffuser or baffles.
The Photometric pattern allows you to use a manufacturer's .ies goniometry file to describe the
distribution.

When prompted select your object (the Photometric pattern will first prompt you for your .ies file.)
Provide a name for your light.
Hit enter to accept default values for the other prompts.

Additional Notes:

By default, all lights will direct their light straight down. Depending on your scene, you may need to aim your light in a
different direction. Before you begin the aiming process, it is often easier to have a target object to snap to. Right click
on the light in the list, and select Aim < to aim your light. The different patterns will have different prompts to follow.
To change the properties of your light, right click on the light in the list and select Properties.
Click here for additional information on using IES (photometric) lights .

Video Tutorial

Interior Lights Video
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Watch Video
www.youtube.com/watch?v=efA5Z-sPGpg

In this Video, Daniel will show you how to convert existing geometry in your model to lights, and to place new lamps into your
model using nXtRender for AutoCAD. 
Additional
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The Backgrounds Tab
Select a background image and set parameters.

Channel: Visible, Reflected or Refracted.

You can set the same image for or a different image for each.

Type: Color and Image, HDRi or Sky
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Intensity
Gradient - Solid Color, 2 Color Gradient or 3 Color Gradient

When you select a gradient type, you can enter the colors to use

Color - solid color for background

Use Image
Image for Background. You can select an image and set a scale and offset to position it.

Projection - Planar, Cylindrical, or Spherical.

For Planar Projection, you can set the scale and offset to adjust the image:

XScale
YScale
XOffset
YOffset

Other Projections have similar settings.
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The Advanced Lighting tab
The Advanced Lighting Tab provides more detailed options for controlling lights.
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Its controls are:

Engine - Standard (Packet Mode), Path Tracer, or Hybrid. See: nXtRender Rendering Engines
Sky. This defines a hemispherical light source, infinitely far away from your model. There are four options for Sky
lighting: Off, Auto, HDRi , and Color and Image. The automatic Sky provides an analytical model based on real-world
sky conditions. The parameters for automatic Sky can be adjusted on the Sun tab.
Sun. The Sun is a directional light source infinitely far away from the model. The Sun control allows the Sun to be
turned on and off.
Studio Brightness. Studio Brightness reduces the brightness of the Sun and Sky by a factor of 20, mimicking the
interior lighting levels of a photographer's studio.
Lights. This enables and disables artificial lighting.
Indirect. This is the lighting reflected off of surfaces. By default, it is on for interior lighting presets and off for
exteriors and studio models. It is also possible to turn on indirect lighting for exterior renderings.
Indirect Bounces. This controls the number of reflections caused by an indirect light, ranging from one to four.
Color Bleed. Color Bleed controls the amount of color transfer associated with each indirect bounce. It varies from zero
to one.
Ambient. - High, Medium or Low
Automatic Daylight Portals. A daylight portal is an opening for Sun and Sky lighting for an interior rendering.
Automatic Daylight Portals sets all transparent materials as daylight portals.
Monte Carlo Reflections. This checkbox is intended to resolve blurry reflections containing small, bright areas. This
comes at a performance cost. The standard reflection algorithm almost always converges faster, even with blurry
reflections.
Disable caustics
Reflective Bounces.
Refractive Bounces.
Lights Per Pass. A specified number of lights are rendered each pass. Increasing the Lights Per Pass increases the
information contained in each pass, but requires more time per pass.
Channels. This controls the number of channels for multi-channel rendering.
material Glow Channel

Fog

Only available with Path Tracer or Hybrid Engine.

Enabled
Scattering - controls the probability of the light encountering a particle in the fog boundary. Higher numbers produce
denser fogs. The default of 20% is adequate for many uses.
Scattering Direction - controls how the light is scattered. Values > 0 produce forward scattering. Values < 0 produce
backward scattering, similar to reflection. The default of 0.2 produces a pattern which resembles water droplets
suspended in air.
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Absorption - is the probability of light being absorbed in the fog boundary. Higher numbers produce darker fogs. This
is normally left at 0%.
Fog Color

If Scattering or Absorption is too high, then you may just get a dark rendering with no light passing through.
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Materials Palette
Use the Materials Palette to enter information about the materials - colors, textures, reflection, etc.
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Materials Tab
Materials Tab

Icons across the Top:
New Material - Select a new material from one of the standard types.
Get Material from File - Browse the disk for a .ArMaterial file to load into the drawing.
Save Material to a File - Save the selected material in the List of Material onto the disk
Edit Material - Edit the selected material using the Advanced Material Editor
Attach Material to Objects - Attach the selected material to one or more objects in the drawing.
Remove Material from Objects - select an object in the drawing and remove any materials from it.
Material Mapping - Select an object and define special mapping - Box, Planar, Cylindrical, etc.
Quick Mapping - Map material by origin and axes

New Material Types:
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New Material Types

List of Materials in Model
These are the materials you have created, or loaded from libraries on the disk.

Drag any material onto an object in the model to place - either on that object - or on all objects in the same layer.

Drag any material onto the Layer list below to assign it to that layer.

Layers and Material Assignments
This lists the layers in your model, and any materials assigned to that layer.

Drag any material from the material list above onto a layer name to assign it to that layer.

Video Tutorial
In this Video, Daniel will show you how to create materials and use materials from libraries using nXtRender for AutoCAD.

Create a solid color material, create a material with a texture, select and place materials from libraries.
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Advanced Material Editor

The Advanced Material Editor allows the user to control many specific characteristics of their material. It is organized into four
tabs.

Main Tab
Color - set the color or materials without a texture.

Reflective Finish and Highlight' The two sliders combine to define the amount of reflection and the sharpness of reflection.

Highlight Color

Metallic - highlight are reflected in the color of the reflective material.
White - highlights are in White
Custom - highlights are in a custom color.
See: Metallic Reflection

Glossy - highlights are other reflections are blurry.

See: * Glossy Reflection

Intensity of the reflection. 1.000 is fully reflective.

Sharpness - values less than 1.000 create blurry reflections

Fresnel - sets the amount of Fresnel Reflection .
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The Fresnel setting is useful for glossy materials, not transparent ones.
The Fresnel setting affects only reflective materials. It controls an effect known as fresnel reflection of conductors. If
your material is not 100% transparent, then this setting may come into play
Fresnel reflectivity of conductors models the tendency of many materials to become more specular (mirror-like) at
glancing angles, while retaining more matte properties at perpendicular viewing angles.

See also

Material Settings - Reflection
Highlighting
Fresnel Reflection

Transparency Tab

The Transparency tab of the Advanced Material Editor controls a number of different properties associated with light passing
through a material.

Intensity. This affects how transparent the material is.
IOR. Index Of Refraction determines both the reflectivity of the material and how refractive it is. Controls the amount
that light is distorted as it passes through thick glass.

The higher the IOR, the less transparent and the more reflective the glass is. Lower values of IOR will result in more
light on the inside.

Translucency. This is a measure of diffusion. High translucency produces a "sandblasted" effect, since more light is
scattered randomly through the material. Allows light to pass through the material, but not visibility - as with a lamp
shade.
Attenuation. This is a measure of the loss of intensity of light as it passes through the material. Sunglasses, for
example, have a high attenuation.
Dispersion. This controls how much light is split into its component wavelengths.
Saturation. This determines the amount of dispersion.
No Daylight Portal. This checkbox prevents the material from becoming a source of sunlight for an interior rendering.
Glow. This creates the illusion of illumination. Sets Self Glow - the face glows, but does not illuminate other surfaces.

Texture Tab
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The Texture Maps tab contains a number of options for altering textures as well as an ordered list of the maps being used.
The controls for adding and removing maps, as well as re-ordering them, are at the top of this list.

The four tabs below the map list are:

Main. Controls for the scale of the tiling, replacing the current map, and changing the map type, are located here.
Depending on the choice of map type, there are additional controls. For standard maps, the user is able to set
Strength (how clear the texture is) and Bump, which uses the map's gradient to create the appearance of depth.
Normal maps only have a bump control. For displacement maps, the user can alter height, facet size, and z-offset.
Masking. By default, the alpha channel will be masked. By selecting "Color" instead of "Alpha," it is possible to mask
any RGB value. The Transparent checkbox sets the masked color to transparent. The Reverse checkbox masks
everything but the masked color. Blur determines the magnitude of partial masking around the masked color, and
Sensitivity measures the size of the area around the color that is also masked.
Channels. The controls for channel manipulation are located here. Invert Channels switches RGB values, so dark
becomes light, blue becomes orange, etc. The Color checkbox turns all colors on and off. Specular Intensity makes
the material more reflective and mirror-like. Specular Color blends the highlight color (under the Main tab of the
material editor) and the texture map's color for specular reflections.
Orientation. Rotation rotates the tiles, Offset X and Y move the tiles around on the surface of the material.:

You can place up to 4 texture images on your material.

You can specify special effects for additional textures - such as blending materials, or using the second material as a Bump
Map 

Bumps Tab
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Sets special procedural bump types. Each bump type has its own parameters.

The Bumps tab provides options for creating the appearance of a specific kind of surface without using displacement maps or
requiring the user to provide any additional maps. The patterns offered are: Sandpaper, Rubble, Wrinkled, Marbled, and
Pyramid. When one of the bump maps is checked, additional controls become available. Strength controls the appearance of
depth. Scale controls the proportional size of the bumps.

See: Procedural Bump Maps

Special Blends
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Some materials, such as Solid Wood are created by blending several sub-textures.

This feature is mostly undocumented. The best way to use it is to choose an existing material and to try to change the
settings to achieve the desired effect.
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The Material Tree
The Material Tree allows the user to combine two "parent" materials based on a specific method, creating a complex "child"
material. Two "child" materials can be combined in the same way, yielding a more elaborate material.

The methods for combining two materials are:

Marble. Consists of alternating slabs of vein and base materials. This is a 3D pattern defined for all points in space.
Granite. Produces a spotted pattern. The spots are solid pockets of material embedded in a base material.
Wood. This combination method produces concentric cylinders of alternating base and ring material. For realistic
results, it is important to map correctly.
Blend. This is a simple option to combine two base materials and control the proportion of each one.
Angular Blend. This blends two materials from different viewing angles. It is useful for materials that are reflective at
glancing angles and not reflective at 90 degrees. However, Fresnel effects are a physically-based way of producing
similar effects.
Tile. This is a 2D procedure that combines two materials - one as a tile and the other as the joint between tiles.
Fractal.

Depending on which procedure is selected, different controls are available to the user. Marble, Wood, Granite, and Fractal all
draw from the same set of controls. They are:
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Feature. The ratio between base and stripe, spot, or ring is accessed through this control. It varies between 0 and 1.
Lower values mean a higher ratio of base to feature.
Blend. This controls how much partial combination of the two materials occurs.
Bump. Creates the appearance of bumpiness. It ranges from -1 to 1. Negative values make the base appear concave,
while positive values make it appear to stick out.
Turbulence. This is available for only marble and wood. It determines how chaotic the features are. A value of 0
produces perfect rings. Higher values distort and twist these rings.
Octaves.
Absolute Value.
Veneer. This checkbox applies a 2D surface veneer instead of a 3D blend of materials.
Scale.:
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Other Palettes
Use the Render Settings Palette to enter information about the rendering.

Use the Object Properties Pallette] to set special rendering properties for objects.
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Render Settings
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There are three options for determining resolution: Viewport, Pixels, and Print. Viewport allows the user to set the number of
total pixels. nXtRender's default setting of 300,000 pixels is often sufficient for proofs or images going to the web. 3,000,000
or more may be required for a final, printed image. Pixels allows the user to set resolution for both X and Y axes.

Depth of Field

This effect creates a depth of field blur that mimics a photographer's lens. A lens can only focus precisely at exactly one
distance, but the decrease in sharpness is gradual around the focal distance, creating an area that is acceptably sharp.
"Strength" controls the size of this area. A strength of zero means that the entire image is sharp. Increasing the strength
makes the areas outside the focal distance more blurry and makes the area in focus smaller. "Focal Distance" sets the
distance for the depth of field.

Use Plants - uncheck to suppress the rendering of Tree Editor plants
Use Materials - uncheck to render without nXtRender material textures or colors.
Use Object Colors - check to render AutoCAD materials using their AutoCAD colors.

This is only active it Use Materials is checked.

Passes - stop rendering after this many masses if not 0
Automatically Save Rendering Every - save a rendering after each XXX passes.
Browse - set path and file name for autosave file.
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Object Properties

Object Properties

set special lighting, transparency and rendering properties of groups, components and faces.

Object Properties can be used to make any face or object act as a light source, or to set other special
properties.

Object Properties are properties placed directly on model entities to specify rendering properties of the entities.

Settings which are better set on a material, are defined using the Material Wizard

To set object properties, right click on a face, group, or components and select IRender Object Properties. There are two
classes of Object Properties - Lighting and Other Object Properties.

Lighting

Causes this entity to act as a light.

Light Type

None - do not treat this object as a light.
Diffuse / One Sided - all light goes in one direction. This should be used for ceiling lights and other area lights.
Omni-Directional or Isotropic (all directions)
Spotlight - should only be used for the lens of a spotlight.

Light direction (Component or Group)

Spotlight and Diffuse light needs to have a direction.
For lights assigned to faces the direction will always be a perpendicular from the front side of the face.
For components and groups, you can assign the direction based on the axes of the component, or the transformation
of the group. If you create a spot light which points down (in the negative blue axis of the component, then select -
Blue for the Light direction.

Intensity - In watts or lumens

Spot Lamp Settings

Beam Angle - For Spot lights - see Beam Angle
Field Angle - For Spot lights - see Field Angle

The color of the light will be determined by the color of the SketchUp entity.

Other Object Properties

Set the values desired:

Daylight Portal - Produces realistic sun and daylight effects from windows.

See: Daylight Portal

Caustics - Creates caustic refraction of light for a transparent object.

See Caustic Illumination

Thick - Marks glass as created from more than just a single face.

See Thin - Thick

Invisible - the object will be sent to the renderer, but marked as invisible.

See: Invisible
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Alpha - You can mark objects as Alpha Channel, and they will appear invisible but shadows cast on them will appear.
This can be used to let your model cast shadows on walls or nearby buildings, and then paste the rendered image and
the shadows on top of a photographic background.

See: IRender Alpha Images

Ground Cover
See: Ground Cover for defining and assigning Ground Cover foliage to a surface.

Object Properties vs Material Settings
Some object properties - such as thin/thick glass can be set either on a material, or directly on an object.

The advantage of setting the property on the material, is that you can create a material - e.g. ThinGlass - and place it on all
thin glass objects.

The advantage of setting the property directly on the face of the glass, is that you can then set an SketchUp material on the
glass and it will render as thin glass without having to make a new (thin) material for each color of glass which you want to
use.
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The Advanced Object Properties Tab

The Advanced Object Properties Tab controls a number of settings that can be turned on and off, as well as a control for
tessellation.

Thin
Daylight Portal
Caustics
Alpha Channel
Faceted
Reverse Normals
Monte Carlo Reflections
Gather
Tessellation controls how many flat faces are used to create the appearance of curvature. A higher value means
more faces, resulting in a better approximation of curvature.:
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WalkAbout
The WalkAbout interface provides a variety of services encapsulated into a single nXtRender utility. Its basic functions
include:

An alternative to AutoCAD viewing and navigation commands, including an intuitive walk-through mode.
Fixed aspect ratio viewports so that exact views can be replicated consistently, even across different machines.
An interactive image background interface for placing models into photographs.

Some advanced features can only be accessed through the WalkAbout interface. These include:

Additional projections not found in AutoCAD, such as two-point perspectives and panoramas.
A batch processor which allows you to calculate and save multiple renderings in a single session.
3D Slide Show-- an easy to use yet sophisticated animation engine.
A sun study animation engine.
The ability to render a rectangular region of your view.:
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3D slide show animations
3D slide shows are made by rendering transitional views between views that have been saved by the user. The output is a
number of images (.png) that form a slide show animation that transitions from one saved view to the next. To create a 3D
slide show, go to the WalkAbout interface and save at least two views of the model. This is done with the "Save Current View"
button.\\

Once multiple views have been saved, click the "3D Slide Show Animation" button, to the right of the "Save Current View"
button.

This leads to the 3D Slide Show dialog box. It contains an ordered list of the different views, as well as controls labeled
"Transition (Seconds)" and "Delay (Seconds)." These affect the length of the transitions between views, and the time spent at
each saved view, respectively. This dialog box also contains three additional tabs, which are:

Quality. Since 3D Slide Shows require many renderings, the default resolution is lower than for a still image, as
is the number of passes per image. Frames per second controls the frame rate for the transitions. This means
that more frames will be rendered, giving the animation a smoother feel.
Exposure.
Output.

The "Preview" button shows what the animation will look like with the current settings. "Render" will render the output images,
and "Farm" uses the nXtRender Render Farm to produce the output images.
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nXtRender Add-ons
These Add-ons for nXtRender are available as a separate download.

Download and Installation
After they are installed, they will appear on the Plugins Ribbon, or you can type in the command directly:

RPS_AC_RENDER_READY - nXtRender Render Ready lights and other objects
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nXtRender Background Wizard
The nXtRender Background Wizard is used to easily position background images and HDRi skies behind your SketchUp
model before rendering.

Download and Installation
You can download the nXtRender Add-ons from:

nXtRender Add-ons

After they are installed, they will appear on the Plugins Ribbon, or you can type in: RPS_AC_RENDER_READY

The nXtRender Add-ons can be download from: Add-ons for nXtRender.

Background Positioning

The Background Wizard makes it easy to position your rendered model in a background, and to remember the settings for
future renderings.

In this sample, we loaded a background image which did not match the perspective of the current AutoCASD view.\

 

By loading the background wizard, we are able to see the background image both behind the AutoCAD view, and through the
transparent windows. By dragging the handles on the background image, we can get the matching we want.
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And then, we we re-render the model, we get a background which aligns with the current view.
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Using Background Wizard
First select the view and background image you want from the nXtRender panel
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From the nXtRender Ribbon, select Image Wizard

This will load the Background Wizard showing the AutoCAD view superimposed over the background image.
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Background Positioning

These values show the offsets and scales which are applied to the rendering engine when positioning the background.

Maintain Aspect Ratio

if this is checked, then the when stretching the image, the original aspect ration will be maintained.

Distortion
Off - Background is always rectangular
Perspective - Right and Left side can be expanded or reduced to product a perspective effect.
Full - all four corner points can be changed independently

Reset Position

Resets to the default scale and offset

background Image filters

Apply some simple filters to the background image.

Zoom Background Images

Zoom,In, Soom Out, Zoom All, Zoom to rendered area only

Show only render area

When not checked you can see the full background image, outside of the rendered image, and use the handles to
stretch or scale the background.

Show model as Wire-frame

This can make it easier to see the background image behind the model.

Opacity
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Makes the AutoCAD image more transparent so you can see the background better behind it.
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Layer Material Schemes

Layer Material Schemes is a feature of nXtRender for AutoCAD.

It is used to easily save and reload assignments of nXtRender Materials to models.

Loading The Wizard

In versions of AutoCAD with a ribbon, you can load the Layer Material Schemes from the Ribbon.

Or you can just type in nXt_Layer_Materials

For AutoCAD 2010 and 2011, which do not have a Ribbon, you will need to load one of these ARX modules before the
functions will work:

nXtRender_load_R18.arx
or

nXtRender_load_R18_x64.arx (for 64 bit machines)

These modules can be loaded from a sub-folder named RPS_BIN wherever you have AccuRender nXt installed, usually:

C:\Program Files\AccuRender nXt\RPS_BIN

Display Panes

Saved Schemes

The left hand column is used to select either the Current Drawing, or a Layer Material Scheme saved in the Library to apply to
the model.

After selecting a saved scheme, or using Browse to select a scheme with Windows File Explorer, the Layer Assignments saved
in the scheme, and thumbnails of the materials in the scheme are displayed in the two right hand columns.
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Browse - select a saved Scheme from anywhere on the disk, not just the Layer Material Scheme Library.

Options - change the location of the library of schemes. This is useful if you want to save schemes on a network drive to
share with other users.

Layer Material Scheme

The layers and materials in the current scheme are displayed in the center pane. You cannot make any changes here, but
you can see which materials will be applied to each layer.

Show All Layers - Normally only the layers contained in the scheme are displayed. Show All Layers will display all layers in
your model.

Thumbnails

The right Hand Pane displays thumbnails of the materials saved in the Scheme.

Save - After clicking Apply, or after selecting Current Drawing in the left hand pane, you can save the scheme to the Layer
Scheme Library, or anywhere else you like.

Apply - will apply the selected Layer Scheme to the Current Drawing. Materials for layers not contained in the scheme will not
be changed,

Close - close the Wizard without making additional changes.

Saving a new Scheme
After you click Save, when the Current Drawing is selected in the left hand Pane), you can eiter save the scheme to a library,
or use Save As to save it anywhere on the disk.

Scheme Libraries

The initial library location is in the Windows AppData scheme, under nXtRender/Material Schemes, you can use the Settings
button or the Change Library Location button on thhe Save dialog, to specify a new location for the libraries.
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nXtRender Render Ready
nXtRender Ready blocks are have light and material settings already saved in the blocks so you can place them in AutoCAD
and render them without having to add lighting and other parameters.

Download and Installation
You can download the nXtRender Add-ons from:

nXtRender Add-ons

After they are installed, they will appear on the Plugins Ribbon, or you can type in: RPS_AC_RENDER_READY

The nXtRender Add-ons can be download from: Add-ons for nXtRender.

Here are some ceiling lights:
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Here are some other lights:
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Rendering with nXtRender

After clicking Create/Place and rendering the model, here are the download lights in action.
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Notes
Some lights, such as the wall lights will require you to set the AutoCAD UCS to the desired wall for placement.
Currently, if you re-install nXtRender, you will need to re-install the nXtRender Add-ons as well.
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Using Burn
Burn changes the white point of the image so that less than max brightness objects will map to white. Here are three images
all with exactly the same luminance data but different exposure (tone mapping) settings.

First, with no modifications to the tone mapping you can see that the average color maps to gray:

With the brightness cranked up to 0.4 we can get rid of some of the "grayness" of the image. Think of this as intentionally
overexposing a photo a little:
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Finally, adding some burn can really make a big difference in the brighter regions of the image-- in this case I used 0.5.
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The amount of burn you'll use varies quite a bit from scene to scene - There are no good rules of thumb here.
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nXtRender Image Editor
The nXtRender Image Editor is a powerful stand-alone utility which can edit native image files (.nXtImage) produced by any of
the nXtRender platforms. These native files retain all of the information gathered during rendering. Launch the Editor from
the Start menu's nXtRender folder.

Using the Editor, you can:

Adjust the tone operator settings
Change the intensity of any lighting channel
Add special, image-based, effects such as Haze or Depth Blur
Save a tone-mapped image in a popular format such as .jpg or .png
Save the luminance information to an HDR format
View and save additional masked channels (alpha, distance, material) for use in advanced compositing
Save a Piranesi(c) file format (*.epx) which can be used to create non photo-realistic rendering
Use Image Arithmetic for tasks such as stitching together an image which has been generated by separate
nodes on the render farm.
Save the Lighting Settings used to generate this rendering. These Lighting Settings can then be used to
generate more renderings.

After saving your rendering results as an .nXtImage, use the File->Open... menu to load the image into the editor.

As you move your cursor over the image, the status bar displays the following information about each pixel:

The pixel coordinate, measured from the lower left corner
The resulting color and alpha in RGBA format of the pixel after tone-mapping
The actual luminance value stored in each pixel as RGB and single channel Y. This is the direct result of the
lighting calculation. If accurate lighting information was used to produce the rendering, these values will have
units of candelas/m^2.
The distance of each pixel from the viewer in meters. Negative values indicate a background pixel.
The name of the material used to render the pixel.

nXtImage files contain three additional channels which can be used as masks for advanced compositing in most bitmap
editors. These channels carry alpha (transparency), distance, and material information for each pixel, encoded in a gray-scale
image. Each channel can be viewed and saved to a .png file.

Use the View pulldown to view each mask channel. Use the File->Save Mask option to save a mask channel to a .png image.

Additional notes:

The Alpha channel can be included with a tone-mapped image by selecting a file format w/ Alpha when saving a
tone-mapped image.
Distance and Materials channels are not anti-aliased and may show some hard-edged artifacts. Adding a small
amount of Gaussian blur to a mask before using it may help soften these edges.
The Materials channel will only uniquely encode 255 different materials. If your drawing contains more materials
than that, some mask colors will repeat.
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nXtRender Batch

nXtRender Batch

Batch Rendering is a rendering mode which exports the model to a file, and then renders the file in a
separate process.

It has 3 main uses and benefits.

1. Large Models - Models which are too large to render directly from SketchUp can be rendered in
batch mode.

2. Animation - Batch mode is used for animation, because animations need to load and reload the
model when there are layer changes, and because animations typically take a long time to render.

3. Network Rendering - The entire folder containing the rendering information and files can be
accessed across a network, or copied to a thumb drive or another machine and used to render the
model.

nXtRender Batch Rendering exports the model to a file, and then renders the file in a separate process.

It has 3 main uses and benefits.

1. Large Models - Models which are too large to render directly from SketchUp can be rendered in batch mode. Batch
Rendering can process models which are 2 to 5 times larger than Direct Rendering.

2. Animation - Batch mode is used for animation, because animations need to load and reload the model when there
are layer changes, and because animations typically take a long time to render.

3. Network Rendering - The entire folder containing the rendering information and files can be accessed across a
network, or copied to a thumb drive or another machine and used to render the model.

nXtRender Toolbar Functions

These are the functions for each of the buttons on the Render Dialog Toolbar:

 - Load the About dialog

 - Image Filters and Tone Operator - Adjust Image Brightness, Contrast, Burn, and Saturation or apply other
filters.

 - Brightness Control - Adjust the brightness without loading the Tone Operator
dialog
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 - Save the rendered image to a JPEG or PNG file. See: Saving Rendered Image

 - Copy rendered image to clipboard

 - Zoom All - This button will toggle the render display between showing the actual pixels and filling the
current window.

 - View Rotate - Change View and re-render.

 - Render Setup Dialog - Change Setup Options before restarting the renderer.

 - Render Material Dialog - Change Materials before restarting the renderer.

After changing Setup Options or Materials, use the Start Render button  to see the changes.

 - Lighting Channels - adjust the intensity of sun, sky or groups of lights directly.

 - Image Effects - Switch to nXtImage Format for special effects - Real Time Haze , Depth Blur and Glare

 - Resume Rendering - Use the Resume button to add more passes to a rendering which has been
completed. See: Resume Rendering .

 - Start Rendering - This button is red while the renderer is processing. It will turn green when the rendering
in finished. Click on the red button to stop the rendering. Click on the green button to restart the rendering.
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Settings
Click Batch Rendering Settings pn the Render Setup Wizard to change the default folder or behavior. 
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Folder to Use

Batch Rendering stores everything needed to render the drawing in a folder on your disk. This lets you render the drawing
from a network machine, or render it later if desired.

Standard - the standard folder is stored in your Windows temporary folder. It is reused every time you start a Batch
Rendering. The folder is nXt_Batch.
Model Name - the Batch Rendering folder name is based on the name of the current SketchUp model.
Custom - you can enter your own name and location for the Batch Rendering folder.

For Batch Rendering on a Network Computer, select Custom and save the rendering information on a drive on your computer
which is accessible by the network computer, or save it directly onto the network computer.

Action to tak when batch data complete

The second two options cause a pause in the rendering process so that you can start the rendering on a separate network
machine, or delay the start of the rendering, if desired.

Start batch rendering - the rendering is automatically started after the data is extracted from your SketchUp model.
Load this dialog before rendering - this dialog is re-loaded before rendering so that you can set the Batch Rendering
folder.
Notify me that data is ready - A message box is loaded to show that the data is ready.

Import option changes from Batch Rendering Window

When you make changes to your rendering settings, materials, etc. from the Rendering window, these can be reloaded back
into SketchUp. (Assuming you are still working on the same model in SketchUp).

Load dialog to ask - Sketchup will load a dialog asking if you want to import any changes made while renderings.
Always load changes - Always load the changes into the SketchUp model without asking first.
Never Load changes - Do not load the dialog and do not load any changes back into SketchUp.

Network Rendering
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This message will appear if you check: Notify me that data is ready on the Batch
Rendering Setup Dialog.

Remote Rendering

External Rendering exports the model to a file, and then renders the file in a separate process.

This allows you to make changes to the SketchUp model wihtout having to wait for the rendering to
complete

After extracting the data from the SketchUp model, you can access the entire folder containing the rendering information and
files across a network, or copy the folder to a thumb drive or another machine and use it to render the model.

If you check: Notify me that data is ready on the Batch Rendering Setup Dialog you will be prompted when the batch data is
read, and you can start the rendering on the remote machine. a DOS .BAT file is created in the batch rendering folder which
will start the rendering for you.

Installations

nXtRender: You must install nXtRender in the same location on a network machine if you want to render from the network
machine. You do not need to install SketchUp and you do not need to authorize nXtRender for the batch rendering network
machine.
SketchUp: You do not need to install SketchUp on the remote machine.
RPC:: If you are using RPC objects, you will need to install the ArchVision Content Manager on the network machine.

Licensing

nXtRender: You do not need to license nXtRender of the Remote Machine.

Batch Rendering Editor
You can edit materials or options in the Batch Renderer, and re-render the model without returning to SketchUp and then
reload the changes back into SketchUp.

See: Batch Rendering Editor

Licensing for Batch Rendering
You do not need a license for a Batch Rendering machine.

You need a license for each machine which is running the 3D Modeller and wants to access nXtRender from within the 3D

Rendering with AutoCAD using nXtRender

Batch rendering - 10.3 - 120 -

http://www.nxtrender.com/wk/Rendering_Editor.htm


Model.

You do not need a license for machines which are used only to perform the renderings using the Batch Rendering process. As
long as these machines do not need to access nXtRender from within AutoCAD, SketchUp or Revit - they do not need a
license.

Render Farms
A Render Farm consists of a group of networked computers working together to complete large rendering tasks. Render farms
proceed silently, without graphically displaying the renderings as they progress, or you can run the Render Farm Display tool
to display parts of the image as they are completed. Using the Render Farm allows you to use more compute power for
lengthy tasks at the expense of some interactivity.

See: Render Farm
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nXtRender Render Farm
A Render Farm consists of a group of networked computers working together to complete large rendering tasks. Normally,
render farms proceed silently, without graphically displaying the renderings as they progress. Rendering in this manner allows
you to use more computer power for lengthy tasks at the expense of some interactivity.\\ Many third-party render farm
products are currently available. The nXtRender Render Farm Software allows you to work with one of these, or you can set up
a simple render farm just using the software provided. The nXtRender Render Farm Software is sold separately from the
nXtRender platform plugins, such as AccuRender nXt. The software itself is platform independent; AutoCAD is not required on
computers which will only be used for rendering farming.

The nXtRender Render Farm includes two basic pieces of software:

nXtFarmer.exe (nXtFarmer64.exe) is a small program that runs on each network rendering station and waits for jobs to
be generated.
nXtFarmMonitor.exe (nXtFarmMonitor64.exe) is an applet that shows you the state of your render farm and provides
some simple control tools.

The following procedures apply to nXtRender's included render farm. If you are planning to use third-party render farm
software, some of these procedures will be different.

Create a shared folder for use by the render farm. All of the network rendering computers must have read/write access to this
folder. The shared folder should have a lot of available disk space to store both data (input) and images (output.) 20 - 200
GB of available storage are recommended. You must perform the following four steps on each computer you plan to use in the
render farm, including any nXtRender workstations which will submit jobs to the render farm:

Install the nXtRender Render Farm Software.
From the Start menu, run the Render Farmer on each machine. The Render Farmer will appear as an icon in the
system tray.
Right click on the icon and select Restore. A window title nXtRender Farmer should appear.
Select Options->Path... from the menu and select the path to the render farm. The Farmer window can now be
minimized to the tray.

The Render Farm is now configured. To verify that the farmer machines are responding run the Render Farm Monitor from the
Start menu on any of the workstations. The machines should appear in the upper list box. If you wish to exclude a machine
from participating in the render farm, you can select it, right click, and choose Suspend.

Updating the Render Farm Software

All participating computers must be updated before a new job can be submitted to the farm. Use the following procedure:

Wait for any active farm jobs to complete before beginning your update.
For each participating computer:

   - If the render farm is currently running, close down the Render Farmer by    right-clicking on the tray icon and selecting Close.

- Install the nXtRender Render Farm Software.
- Run the Render Farmer from the Start Menu. The tray icon should appear.

Currently, three types of jobs can be submitted to the render farm for processing by multiple computers: Single Images from
WalkAbout, Batch Jobs, and 3D Slide Shows.

Single Images

Single views can be split into "slices" and distributed to multiple machines. Once the job is complete, these slices can be
reconstructed into a single image using the nXtRender Image Editor.

Perform the following steps to submit a single image job to the render farm:

Launch WalkAbout and configure your rendering and view.
Press the Render Farm button on the WalkAbout toolbar.
Name the job or accept the default. The date and time is automatically pre-pended to the name you choose. A sub-
folder for the job is created in the Render Farm shared folder. An Output folder is also created in the new job folder.
Choose to either run the job "now", "later", or "after" a scheduled time. If you choose "later" you will need to use the
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nXtRender Render Farm Monitor to manually start the job.

After the job is complete, output can be found in the job's Output folder. To reconstruct the output into a single image use
the following steps:

Open the nXtRender Image Editor.
Load the first image of the sequence, 000000.nXtImage
From the menu, select Image->Arithmetic->Add
Select all of the other images in the sequence (do not select 000000.nXtImage again or it will be counted twice)

Batch Jobs

Each batch task will be rendered by a single machine.

Perform the following steps to submit a Batch job to the render farm:

Configure your Batch tasks in the usual way.
Press the Farm... button on the Batch DB.
Name the job or accept the default. The date and time is automatically pre-pended to the name you choose. A sub-
folder for the job is created in the Render Farm shared folder. An Output folder is also created in the new job folder.
Choose to either run the job "now", "later", or "after" a scheduled time. If you choose "later" you will need to use the
nXtRender Render Farm Monitor to manually start the job.

After the job is complete, output can be found in the job's Output folder. The output format from Batch jobs is always
.nXtImage.

Slide Show

Each transition between two slides will be rendered by a single machine. For example, a slide show with five slides will have
four transitions and will produce four tasks for the render farm.

Perform the following steps to submit a 3D Slide Show job to the render farm:

Configure your 3D Slide Show in the usual way.
Press the Farm... button on the 3D Slide Show DB.
Name the job or accept the default. The date and time is automatically pre-pended to the name you choose. A sub-
folder for the job is created in the Render Farm shared folder. An Output folder is also created in the new job folder.
Choose to either run the job "now", "later", or "after" a scheduled time. If you choose "later" you will need to use the
nXtRender Render Farm Monitor to manually start the job.

After the job is complete, output can be found in the job's Output folder. The output format from 3D Slide Show jobs is always
png. Your alpha channel choice will be preserved.

Render Farm - 10.4

- 123 - Render Farm - 10.4



Converting legacy (AR3 - AR4) material libraries
Online help home

Converting Legacy AR3/AR4 Libraries
Material libraries used by the AccuRender 3 and 4 family of products cannot be used by nXt directly. These must be converted
to folders and .nXtMaterial files before they can imported into nXt.

Standard AR3/AR4 Libraries

The standard libraries have been converted and are available for download Here.

http://nxtrender.com/download/

Your custom AR3/AR4 Libraries

To convert your custom AR3/AR4 material libraries use the tool provided on the Widgets menu of the AutoCAD palette

called Convert Legacy AR Material Library. This tool will convert your material library file into standard folders and elemental
material files, which can then be imported into your drawing. Because the nXt engine is very different than previous AR
engines, some materials may require some additional manual work.

Additional Notes

If a AR3/AR4 version of AccuRender has never been installed on your machine, you will need to tell nXt where it can find the
textures used by your AR3/AR4 materials. This is often the case with new 64-bit machines. Pressing the Options button on the
nXt palette will allow you to enter the search path to your textures.
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Using Legacy AR3-AR4 Plants
Using Legacy AR3/AR4 Plants
Plants created in AccuRender 3 or 4 may be added to a drawing by using the Add Legacy Plant... option in the Widgets->Plants
pulldown.

Navigate to a folder which contains an AR3/AR4 .plib file. Click on the file name to load the library.

Select a plant, and click OK.

Select a location for your plant.

The plant will be placed in the drawing as a wireframe, stick figure.
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Once your AR3/AR4 plant has been inserted, you can edit a few settings of the plant using the Edit Legacy Plant option.

Additional notes on AR3/AR4 Plants
Groundcover and Vines

AR3/AR4 groundcover and vines are not available in nXtRender.

Search Paths for images, etc.

If you are using AR3/AR4 plants and do not have AccuRender 3 or 4 installed, you will need to manually add all of the search
paths necessary for your plants. (Use the Options item on the menu bar to add search paths.)

The necessary paths include the path to the plant library, the path to the plant material library, and the paths to any textures
or opacity maps required by the AR3/AR4 plant.

Missing AR3/AR4 plant materials during rendering is almost always due to missing search path information. This issue is
particularly relevant for 64 bit systems, since these will not have had previous installations of AccuRender.

Existing Drawings

AR3/AR4 drawings with plants already inserted should work subject to the restrictions above.

No Library Conversion

AR3/AR4 plants are very different than the new nXtRender plants. Currently you cannot convert AR3/AR4 plants to
nXtRender plants.
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Volumetric Fog
Volumetric fog allows the atmosphere surrounding your model to participate in the lighting calculation. Effects such as "sun
streaks" or "light beams" can be accurately modeled using this effect. Tips on achieving both of these specific phenomena
are discussed below.

Nighttime fog scene - see Nighttime Fog Tips below. (It took about 1,000 passes for this rendering to converge and smooth out.)
Chick Inn Model courtesy of MuseumMaker - See: Sketching Ypsi

FAQ - Why can't I see any fog
When we first used fog, we didn't see any either. We have fixed, or added warnings, for many of the thing we ran into. But
this list may help.

Most of these items are discussed later in the Volumetric Fog Article

1. Enable Volumetric Fog on the Fog Setup Tab
If you forget this step you will not get any fog.

2. Use the Path Tracer Engine
We have added some warnings if you try to render with Fog enabled, but not the Path Tracer Engine.

3. Don't use Section Planes
There is currently a bug where Fog does not work when viewed through a section plane. You will need to hide or delete
geometry instead if you want to see through walls, etc. until we get this fixed.

4. Wait long enough so that the lights creating the fog appear
The default is for only 1/3 of the lights to appear in each pass, so wait 6 to 10 passes before you give up on the fog.

5. Make sure Scattering is set properly
Scattering is the amoun that light is scattered by the fog. If you don't see any fog, set it to 50%. You can raise or
lower it later once you are able to see the fog.

6. Don't set values too high - If Scattering or Absorption is too high, then you may just get a dark rendering with no light
passing through. 
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7. Check the Fog Boundary
For my first rendering I did not set the fog boundary. Since then we have added some default boundaries - such as
the model boundary.

8. Make sure the fog boundary does not intersect any other faces.
We have made the default boundary 5% larger than the model. If you set your own boundary, make sure there are
not any coplanar faces in th model which intersect the boundary.

To enable volumetric fog
Volumetric fog requires the Path Tracer , it is not available in the standard engine.
On the Lights Tab , click the Enable box in the Fog group.
After you enable fog a box will appear in your model. This box controls the extent of the fog. It can be stretched using
grip points, scaled, rotated, and moved.

Path Tracer Engine

Volumetric Fog requires the nXt Path Tracer engine.

This engine can create special effects like fog, but does so at the expense of a more complex and time-consuming
calculation. The Path Tracer begins by displaying a very grainy or "noisy" image which gradually refines and becomes smooth.
This process is known as convergence. Some scenes will converge very quickly, others will take many hours.

After just a few passes, the image appears quite noisy, but may be sufficient to determine if the scene is set up properly. I
will usually take 100's 0r 1,000's of passes to get a good final image. Each pass is faster than with the Packet Mode Engine,
but it will still usually take longer to get a useable result with the Patch Tracer.

10 passes - early on the rendering has a lot of
unresolved pixels. The final image is beginning to
take shape but will need many more passes before it
is complete.

250 passes - you can see how this is going to work,
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and stop the rendering if you want to make changes.
But it will probably take about 1,000 passes to get a
good image with fog.

1000 passes - after about 1,000 passes the scene
has converged fairly well.

Smoothness Filters

Use of the smoothness filters, included in IRender nXt, can also help resolve the image.

This two images are spot lights in haze, after 250 passes.

The one the left is the images as rendered, the one on the right has a 3x3 Gaussian Smoothness filter applied.

The smoothness helps converge the pixels, and the slight blurriness it adds is acceptable in a foggy scene.

250 passes - original image
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250 passes with Gaussian 3x3 Smoothness filter
applied.

This is the same scene, rendered for 1,000 passes without a smoothness filter. The extra passes definitely create a
smoother, more complete image.

Fog Boundary
The Fog calculations require a boundary to determine where to apply the fog effect.

A radio button is supplied for two simple cases - setting the boundary to the database extrema, and setting the boundary to
the extrema plus camera.

In this lighthouse example, the database extrema do not work well - because the database itself was so small:
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Boundary set to database extrema (plus 10%) after 50 passes. This
does not achieve the effect desired.

Face added to SketchUp to define new model extrema for fog.
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Boundary set to database extrema - with added area to define the fog
boundary.

Settings

Enable Volumetric Fog - remember to also select the Path Tracer Engine.
Fog Color - The Color Swatch allows you to change the scattering color, normally set to white.
Scattering - controls the probability of the light encountering a particle in the fog boundary. Higher numbers produce
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denser fogs. The default of 20% is adequate for many uses.
Absorption - is the probability of light being absorbed in the fog boundary. Higher numbers produce darker fogs. This
is normally left at 0%.
Scattering Direction - controls how the light is scattered. Values > 0 produce forward scattering. Values < 0 produce
backward scattering, similar to reflection. The default of 0.2 produces a pattern which resembles water droplets
suspended in air.

Tips for various conditions
Nighttime Fog

For this image, we set:

Scattering: 40%
Absorption: 5%
Scatter Direction: 0.15

Lighting channels were used to adjust the intensity of the street light and signs while renderings.
The sign on top of the building and the sign at the right were illuminated as lights (using Object Properties or Materil
Illumination)
The other signs were illuminated using self-glow.
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Lighting Channels

One of the other nice features for a nighttime scene like this was the use of Lighting Channels . I was able to assign separate
channels to groups of lights, and then balance them while rendering and after the rendering was complete. This is much
easier than having to change the intensity of the lights and re-render to see the effect.

Exterior 'Sun Streaks'

Exterior Volumetric Fog

Create a multi-channel rendering and place the sun on one channel and the sky on another.
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Using the Channels dialog box, turn the sky down to 0.2. (The particles in the air will act as your "sky". The standard
sky model is not accurate when representing very "low" skies.)
Change the sun direction so your model is lit from behind. Sun streaks will usually only be visible in the dark areas of
your model. Add trees or other shade producing objects.

Interior Light through Window

Use lighting channels to lower sky intensity - to emphasize the sun streaks.
Set scattering to 40% and then raise or lower if needed

Stained Glass example

Interior "Light Beams"

This effect often requires a long time to properly resolve. It may be impractical for some scenes.
Use low density fog. Set Scattering to 20% as a start.
Use focused lighting, such as spot lights with narrow cones.
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Interior Volumetric Fog
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Sub-surface Scattering
Sub-surface Scattering is an advanced material property found only in the Advanced Material Editor on the Transparency
Page. Using this effect, light is permitted to penetrate the surface of your object and scatter in any direction. Many translucent
materials can be modeled using this effect. Certain surfaces, such as stone or skin can be realistically "softened" by allowing
the light to penetrate a short distance.

The lighting in nXtRender normally occurs only at the surface of objects. Subsurface scattering is essentially a volumetric
technique, where interactions also occur within the medium. It's required to accurately model materials which we think of as
"translucent". It's also helpful with materials where the light penetrates the surface a little bit-- such as the marble dragons--
and then scatters on its way out. The feel of the images above would be very difficult to achieve without this technology.

Dragon Objects with varying levels of Sub-surface Scattering

Settings
Sub-surface Scattering requires the Path Tracer to fully realize this effect. It is only partially implemented in the
standard engine.
Scattering controls the probability of the light encountering a particle per unit length. Units can be centimeters
(default), meters, or millimters. Higher numbers produce more scattering.
Scattering Direction controls how the light is scattered. Values > 0 produce forward scattering. Values < 0 produce
backward scattering, similar to reflection. The default of 0.0 produces an isotropic scattering pattern which.
Absorption is the probability of light being absorbed per unit length. Higher numbers produce darker materials.

Additional Notes
The material must have some transparency in order for sub-surface scattering to take place.
This is a volumetric effect. The objects with this material attached must be solid or "space enclosing" for this to work
properly. "Thin" objects should be tagged using Object Properties. Objects tagged as thin will use standard
translucency as defined by the Scattering setting (unitless in this case.)
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Speckle Artifacts
Speckle Artifacts

Bright spot, or speckle artifacts sometime occur during the rendering process. Two common causes of this artifact, and their
solutions, are discussed below.

Blurry Reflection of Light Sources
This problem is usually associated with interior renderings where the light sources are small. The surfaces exhibiting the
artifact typically have blurry reflections. There are three steps you can take to mitigate or eliminate this artifact:

You can tag the material in question as Glossy in the Material Wizard . This will prevent the surface from having any
ray-casted reflections at all and should eliminate the problem and provide better overall performance. Using this switch
may cause some loss of subtlety. For many scenes, however, this is not noticeable. It may be helpful to increase
reflective Sharpness somewhat after checking the Glossy box. See: Glossy Reflection

You can tag the material as No Light Source Reflections. This will allow ray-casted reflections, but will exclude light
sources from appearing in the reflections. This solution will not improve performance, but will allow the surface to retain
more subtle reflections than if you were to use the Glossy switch.

You can use the Monte-Carlo reflection setting, either globally or locally in Object Properties. This option will be slower
and require more processing to resolve.

Solar Highlights
This problem is typically seen on exterior renderings when the Sun Highlight setting is used. You can mitigate or eliminate the
artifact by setting this to a smaller value. See: Sky Setup Tab and Sun Highlight
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Materials assigned by layer are not appearing in the rendering
If you assign a material to an object's layer, but the object continues to render as if it does not have a material assignment
(or as if it has a different material assignment) use the following procedure:

Select the offending object(s)
Click the "Remove Material from Objects" button on the nXtRender Material Tab
Repeat the rendering

The by-layer material assignment should now appear.

Additional Notes

Older models, or models created by 3rd party software, often contain objects or sub-objects whose material is
listed as "Global" instead of "ByLayer". The procedure above must be used on these objects before a layer
assignment will be visible.
The system variable _CMATERIAL controls the default material for newly created objects. It should be set to
"ByLayer".
Using the AutoCAD commmand for removing materials from objects (located on the AutoCAD Materials Palette),
will also work.
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Crash occurs on 32-bit system (hi-res or complex model)
nXtRender is a memory-intensive application which may exceed the limitations of a 32- bit system under certain situations.
When these limitations are approached or exceeded nXtRender may become unstable. These situations include, but are not
limited to:

Complex geometry (either a lot of objects or objects which generate many faces)
nXtRender Plants
High resolution rendering
Use of Lighting Channels
High resolution textures

Avoiding or reducing some of these cases may allow you to render your scene.

64 Bit Considerations
nXtRender, will on 32 bit systems. But will work much better on a 64 bit system with at least 4 GB RAM

Speed
Most models will render faster and better on a 64-bit system.

Note: The Video card is not used for rendering in nXtRender and will not effect rendering speed or performance.

64 bit systems allow you to add more than 4GB of physical memory to a machine-- this will result in performance benefits for
all of your apps., including 32 bit ones.

Model Size
64 bit systems can run much larger data sets (more detailed models-- hi-res renderings, etc.). They are not subject to the
2GB per-process address space problem. This problem is so significant in the SketchUp, AutoCAD and Rhino worlds that we
wouldn't recommend a 32 bit system to anyone looking for a new machine for these purposes. The SketchUp world is more
complicated since SketchUp does not have a 64 bit version.

File Locations
Programs, such as SketchUp, which normally install into Program Files on 32 bit systems, install into Program Files (x86) on 32
bit systems. So many references in the documentation which refer to typical installation locations, such as C:\Program Files\ will
be located in a different location on the 64-bit systems. (Usually C:\Program Files (x86))

Additional Notes

Increasing physical memory or swap file space will have no effect on this problem. The limitation is inherent to
32-bit systems. 64-bit systems do not have this problem.
nXtRender is more memory-intensive than previous versions. Some models which rendered using legacy
versions may not render using nXt.:
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Technical Specifications
Core

Physically-based luminance calculation
Choice of Packet Mode, Path Tracer or Hybrid [[nXtRender Rendering Engines|Rendering Engines]
Progressive refinement algorithm
64-bit version for massive data sets

Multiprocessing

Parallel algorithms efficiently use all available cores
Near-linear performance increase WRT number of cores
Vector-based calculation using SSE
Render farm support (single and multiple images)

Lighting

Analytical sky and sun
HDRi image-based lighting
Up to eight Lighting Channels
IES file support
Luminance values available for all surfaces
Refractive and reflective caustics
Automatic daylight portals for efficient interior daylight simulations

Materials

Efficient displacement mapping with low memory overhead
Normal and bump mapping
Texture set support
Procedural textures and bumps
Blurry transparency and glossy reflection
Fully assignable to ACA components

Entourage

3D plant editor and library
Textured mesh object support (OBJ and 3DS format)
RPC™ support

Ready-made Content

Fractal Trees
Material Library
HDRi Backgrounds

Camera

Perspective
2-Point Perspective
Orthographic
Panoramic
Accurate depth of field

Image Editor and Output

Lighting channel manipulation
Post-process fx like real-time depth of field, haze, and veiling glare.
Image arithmetic
Piranesi™ support
HDR and EXR high dynamic range output
Mask, material, and distance channels
Automatic alpha-compositing

Animation
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Easy to use 3D slide show animation
Path-based animation
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nXtRender Platforms
The nXtRender Engine - based on AccuRender nXt - is available for these platofrms:

nXtRender for AutoCAD
IRender nXt for SketchUp
AccuRender nXt for Revit
Flamingo nXt for Rhino
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nXtRender Contact Information
nXtRender is a rendering engine developed by Render Plus Systems and Roy Hirskowitz and Associates for creating
PhotoRealistic Images from 3D Models.

nXtRender is currently offered for: SketchUp , AutoCAD , and Revit

For Support, visit our Forum at nXtRender.com

Render Plus Systems, Inc. 
6436 S. Quebec St 
Suite 260 
Centennial, Co 80111 

Email: support@renderplus.com 
Website: nXtRender for AutoCAD: nXtRender.com 
Website: SketchUp Products: renderplus.com
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